
Lab 1

The GUI and first Calculations
on Atoms

1.1 Overview

In this lab you will learn how to start the GUI which we will use in all our work. Once
the GUI is operational you will become familiar with its operation and organization. The
basics of running a calculation will be described and you will test out these ideas with a
few calculations of atomic systems and some analysis of results of these calculations. In
particular, the orbitals and their energies will be visualized. We will learn how to calculate
anions and cations and systems in different spin states. Finally, we will learn how to extract
total energies and orbital energies from our calculations to enable us to calculate ionization
potentials and other properties.

1.2 Getting Started

If you would like to know what a GUI is and more about the programs that we will be
using, take a look at the introduction document http://www.cobalt.chem.ucalgary.ca/
ziegler/Chem575/Lab/Intro.html.

1.2.1 Logging onto Rhodium

Quantum chemical calculations often require a lot of computer power and therefore one must
have access to a powerful computer to carry out such calculations. The computer that we
will use in this course is a cluster of nearly 100 dual-processor PCs called Rhodium. The
procedure to connect to Rhodium can be found at http://www.cobalt.chem.ucalgary.ca/
ziegler/Chem575/Lab/Intro.html.

1.2.2 Running ADFINPUT

Once you have logged onto Rhodium you must first set up your environment so that the
computer and ADF know the location and details of several important files. To do this type

source /home/programs/ADF/adf2006/profile.01.sh

and press the return key. It should be assumed that you press return after all commands
that need to be typed into the command line.

We are now ready to run ADFINPUT. To start ADFINPUT type

http://www.cobalt.chem.ucalgary.ca/ziegler/Chem575/Lab/Intro.html
http://www.cobalt.chem.ucalgary.ca/ziegler/Chem575/Lab/Intro.html
http://www.cobalt.chem.ucalgary.ca/ziegler/Chem575/Lab/Intro.html
http://www.cobalt.chem.ucalgary.ca/ziegler/Chem575/Lab/Intro.html
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Figure 1.1: A new ADFINPUT window

$ADFBIN/adfinput &

After a short pause a window should open on your screen that is mostly grey but with a big
black square on the left (see figure 1.1). Various menus and buttons should be apparent.

Play around with ADFINPUT for a while, looking at the various menus and buttons.
One of the tasks that ADFINPUT performs is to build the molecule that we are interested
in. This is the function of the black square and the buttons directly above it. We shall
consider that in a moment.

Documentation for ADFINPUT can be found at
http://www.scm.com/Doc/Doc2006.01/ADFGUI/ADFGUI_reference/page32.html.

Before looking at the builder, we will consider the menus across the top left of the window
(figure 1.2). the blue/orange SCM menu is for accessing other GUIs for analysis of results.
Since we don’t have any results yet we’ll leave that alone for a bit. The File and Edit menus
should be familiar and contain several options that should also be familiar. The File menus
has options for reading a writing Files required for a calculations. The Edit menu lists some
tools for editing molecules built in the black square. The View menu contains options that
control how the molecule being built looks. The Model, Properties and Details menus contain
options that allow you to control the type of calculation that will be run. Choosing one of
these options changes the window on the right hand and allows you to assign values to the

http://www.scm.com/Doc/Doc2006.01/ADFGUI/ADFGUI_reference/page32.html
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Figure 1.2: The menus

aspect of the calculation that you are intested in. For example, if you choose Model:XC
Functional the righthand window will change to give you a menu allowing you to choose your
functional for your calculation.

Exercise 1.1 Choose one menu entry from the File, Edit or View menus, consult the
ADFINPUT documentation at
http://www.scm.com/Doc/Doc2006.01/ADFGUI/ADFGUI_reference/page32.html and
then in your own words describe briefly what that menu entry does. Don’t choose a
generic entry like File:Open or Edit:Copy.

Exercise 1.2 Choose one menu entry from the Model, Properties or Details menus. Consult
the documentation at
http://www.scm.com/Doc/Doc2006.01/ADFGUI/ADFGUI_reference/page32.html and
then give a rough overview of what this menu item controls. List two options you might
choose in the window on the right hand side.

http://www.scm.com/Doc/Doc2006.01/ADFGUI/ADFGUI_reference/page32.html
http://www.scm.com/Doc/Doc2006.01/ADFGUI/ADFGUI_reference/page32.html
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1.3 Building a Very Simple Molecule and Running a Very Simple Cal-
culation

We are now ready to run our first calculation. We will be running calculations on isolated
atoms so the building aspect will be very simple. Before starting we should clear away
anything we have done while playing around with the menus and buttons. To do this, select
the File:New menu option.

Directly above the black box on the ADFINPUT window is a row of buttons with various
labels including C, O, N, H, Cl a benzene ring and an arrowhead. Press the arrowhead. A
periodic table should appear. Select He. Click in the build window. You should get a blue
ball. It’s blue because it’s selected. Click on it again to unselect it. It should now be purple.
This purple ball represents a He atom. See figure 1.3 Now we’re ready to run a calculation
on our He atom.

Save what you have done with File:Save or File:Save As.... Make sure that you save the
calculation with a name that you and your T.A. can recognize easily. Submit the calculation
for running with File:Run.

A new window will appear which will eventually contain a summary of your calculation.
Don’t worry about all the text in this window right now.

Figure 1.3: The periodic table tool and an atom that has been built
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Figure 1.4: The LEVELS program

This seems pretty simple. What about all the options in the menus? We have taken all
of them to be their default value. Many of these options we will not change very often at all.
Several we will change often.

You have now run a quantum mechanical calculation on the He atom. The results of that
calculation include orbitals, energies and many other interesting things. We will now see how
to examine what we’ve calculated.

1.3.1 Orbital Energy Levels and the LEVELS Program

Click on the orange and blue SCM menu and select Levels. A window should appear with
a scale on the left, two lines, two arrows and a label corresponding to your filename (figure
1.4). As you might have guessed, the window is an orbital energy level diagram created from
the results of your calculation. The axis on the left is energy in atomic units.

Exercise 1.3 What are atomic units? A number of webpages could be useful in answering
this question.

Play around with some of the LEVELS menu options, especially the View menu.
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Figure 1.5: The VIEW program

Exercise 1.4 Save a picture of your energy level diagram using the File:Save Postscript
option of LEVELS program. What is your calculated energy of the 1s orbital of He?

1.3.2 Molecular Orbitals and the VIEW Program

Close the LEVELS window. Click on the SCM menu and select View. After a pause, a new
window with a picture of your atom should appear. The VIEW program has a number of
options, many of which we won’t have time to explore in this course. If you are interested in
learning more, consult the VIEW documentation at
http://www.scm.com/Doc/Doc2006.01/ADFGUI/ADFGUI_reference/page127.html The View
menu is useful for changing the appearance of what you are looking at.

For now, we want to look at the orbitals produced by our calculation. Click on the Add
menu and select Isosurface: Double (+/-). Some new buttons and menus should appear at
the bottom of the window (see figure 1.5). Click on the blank menu just to the left of the
0.03, select Orbitals (occupied) and follow the only available options to select the 1s orbital.
You should see a blue ball that is a bit bigger than the He purple ball. Click on the now no
longer blank menu to the left of the 0.03 and select Orbitals (virtual) and the only possible
option to look at the slightly bigger 2s orbital obtained in your calculation.

http://www.scm.com/Doc/Doc2006.01/ADFGUI/ADFGUI_reference/page127.html
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Exercise 1.5 Save a picture of your 2s orbital using the File:Save Picture command

When you are finished looking at orbitals, close the VIEW window.

1.4 Modifying the System. Choosing a Charge and a Spin State

We have been considering the He atom. From the LEVELS and (if you had looked carefully)
the VIEW analyses, it is apparent that what was calculated was neutral He with two electrons.
In our calculations the default is to calculate a neutral system.

1.4.1 Choosing the Charge

What if you want to study Li+ or H−? To see how, first change your atom to a H atom
by selecting H from the periodic table tool and double-clicking on your He atom. You can
also use the H button instead of the periodic table tool. You can check that it has been
changed successfully by selecting the atom and looking at the description at the bottom of
the window. The atom should also now be small and white (figure 1.6). To change the charge
on the H atom select Charge and Spin from the Model menu. One of the options that will
appear on the top right of the window is Total Charge (figure 1.6). It is currently set to 0.0.
Set it to -1.0, save your work and run the calculation.

Look at the results of this work with LEVELS. You will see two electrons so you have
indeed calculated H−.

Exercise 1.6 What is your calculated energy of the 1s orbital of H−? Why is the 1s orbital
of H− much higher in energy than was the case for He?

1.4.2 Choosing the Spin State

We now know how to examine systems of arbitrary charge. All of the atoms or ions that we
have considered so far are closed-shell singlets with no unpaired electrons. What if we are
interested in neutral H? What about neutral He in the triplet state with two α electrons?
The default for the program is to consider a neutral system with equal numbers of α and
β electrons. If we would like to study an atom or molecule with unpaired electrons we will
need to set some parameters.

This can be done with the Spin Polarization option of the Charge and Spin window. The
number in the box next to Spin Polarization is equal to nα−nβ. nα is the number of α spin
electrons in the system and nβ is the number of β spin electrons.

Exercise 1.7 Change your atom to H. Set its charge to 0.0. nα − nβ for neutral H will be
1.0. Highlight the box to Yes in the Unrestricted option of Charge and Spin. With
the ADF program, you a calculation must be unrestricted whenever you are studying
something with unpaired electrons. Run the calculation. Confirm that your atom has
one unpaired α electron using LEVELS and save a picture of your LEVELS window.

Exercise 1.8 Change your atom to He. Set Spin Polarization to 2.0. Run the calculation.
Confirm that your atom has two unpaired α electron using LEVELS and save a picture
of your LEVELS window.
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Figure 1.6: Converting the atom to hydrogen and setting its charge.

Exercise 1.9 Calculate a N atom in its ground state. Look at its orbital energy level diagram
and occupied orbitals. Save pictures of its orbital energy diagram and one occupied p
orbital.

Exercise 1.10 Using the Charge and Spin option calculate the ground state of Cu2+. Save
a picture of the orbital energy diagram.

Exercise 1.11 What does unrestricted mean in this context?

1.5 Energies. Total Bonding Energies and Orbital Energies. The Re-
sults Summary and the Detailed Output

1.5.1 Total Energy and the ADF Output Summary

Possibly the most important property of an atom or molecule obtained from a calculation is
its energy. Where can we find the energy in the results of our calculation?

Take a look at the grey window with lots of text that you get when you run a calculation.
This text is a short(ish) summary of the results of your calculation in text form. If you don’t
have one, you can open an old one by following these steps:



Lab 1 The GUI and first Calculations on Atoms 9

Figure 1.7: Choosing the number of unpaired electrons and an unrestricted calculation.

1. Select the Logfile option in the SCM menu. This will start the program to examine
logfiles but with no file opened.

2. Open a particular logfile with the standard File: Open command.

Near the bottom of the LOGFILE window (about 5 lines from the bottom), there should be
2 lines that include the text “Bond Energy LDA” (see figure 1.8). This is the energy of your
atom or ion in atomic units and electron volts.

Aside: Many computational chemistry programs compute total energies relative to a refer-
ence of completely seperated electrons and nucleii. The energy that you are looking at
here is the energy relative to a different reference. For our current purposes, it is enough
to know that this energy can be used in the same way as the total energy relative to
the more usual reference.

We can now calculate neutral atoms, cations and anions and we also now know where to
look to find the energy of these species.

The first ionization potential of an isolated atom or molecule M is defined as

IP (M) = E(M)− E(M+) (1.1)
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Figure 1.8: The logfile as displayed by the LOGFILE program. The total energy is circled.

The electron affinity of an isolated atom or molecule M is defined at

EA(M) = E(M−)− E(M) (1.2)

Since we can now calculate the energy of M , M+ and M− when M is an atom, we should be
able to use these calculations to predict the first ionization potential and the electron affinity
of M .

Exercise 1.12 Calculate the first ionization potential and electron affinity of B. Compare
your results with what is known experimentally. (IP1 = 8.3 eV EA = 0.3 eV).

Exercise 1.13 Calculate the ionization potentials of Li and Ar and compare your results
with experiment (5.4 eV and 15.8 eV for Li and Ar respectively).

1.5.2 Orbital Energies and the Detailed ADF Output

Orbitals and their energies are often used in the interpretation of experimental observations.
You have already seen what some orbitals look like through the VIEW program. It is possible
to find orbital energies using VIEW. When a picture of an orbital is created the information
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Figure 1.9: Orbital details from the VIEW program.

concerning that orbital is printed in the formerly blank button. This information includes
the energy of the orbital (figure 1.9).

A less cumbersome way to look at the orbital energies is to consult the detailed output
of the ADF calculation. The ADF program produces a text file that includes lots of details
about how the calculation proceeded. This detailed output can be viewed with any program
that you might use to look at a text file. A particularly useful option is to use the OUTPUT
program that can be accessed from ADFINPUT through the SCM: Output menu item. The
OUTPUT program has the advantage that it has a series of menus across the top of its
window that allow you to go directly to important parts of the calculation output.

Exercise 1.14 Look at the detailed output of the last calculation that you have run. From
the Include menu of the OUTPUT program choose the bottom item. This will probably
be *** (NO TITLE) ***. You should do this every time you run the OUTPUT program
because we are not interested in the other parts of the output. Once you have done
this, click on the Properties menu and select Orbital Energies per Irrep (see figure 1.10.
You should now see the energy, symmetry and occupation of the (occupied or virtual)
orbitals of your atom or ion. What neutral atom or ion are you looking at? What is
the energy of the HOMO of this atom?

Exercise 1.15 Calculate Li and Ar. Look at the HOMO energy of each atom. How do they
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Figure 1.10: The OUTPUT program showing orbital energies.

compare with the ionization potentials you calculated in the last exercise?

1.6 Projects

Do 1.6.1 and 1.6.2 or 1.6.3.

1.6.1 Transition metals

Calculate the neutral Fe atom in its ground state. You should be able to find the electron
configuration of Fe on most periodic tables either online or otherwise. Look at its orbital
energy diagram with LEVELS. Save a copy of it. Look at its occupied orbitals with VIEW.
Save a picture of a d orbital. Do the d orbitals look like what you would expect? How does
the 4s orbital compare in size to the 3d orbitals?

1.6.2 Rare Earths

Calculate the neutral Eu atom in its ground state. Look at its orbital energy diagram with
LEVELS. Save a copy of it. Look at its occupied orbitals with VIEW. Save a picture of an
occupied f orbital the 5s orbital. Do the results of these calculations agree with what you
know about the relative reactivity of the 3d electrons of a first row transition metal compared
to the 4f electrons of a lanthanide? Explain.
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1.6.3 Ionization Potentials

Of the first 70 elements (up to Yb), which has the lowest ionization potential? What do you
calculate this ionization potential to be?


	The GUI and first Calculations on Atoms
	Overview
	Getting Started
	Logging onto Rhodium
	Running ADFINPUT

	Building a Very Simple Molecule and Running a Very Simple Calculation
	Orbital Energy Levels and the LEVELS Program
	Molecular Orbitals and the VIEW Program

	Modifying the System. Choosing a Charge and a Spin State
	Choosing the Charge
	Choosing the Spin State

	Energies. Total Bonding Energies and Orbital Energies. The Results Summary and the Detailed Output
	Total Energy and the ADF Output Summary
	Orbital Energies and the Detailed ADF Output

	Projects
	Transition metals
	Rare Earths
	Ionization Potentials



